
Digital Performer 9.1.3 Read Me

Thank you for installing Digital Performer 9.1.3.

*****

Complete DP9 documentation
You can find complete DP9 documentation (PDF files) on the DP9 installer disc, and 
you can also access them directly from Digital Performer's Help menu. Table of 
Contents entries, index entries, and cross references are live links that will jump to their 
destinations. In some cases, you may need to click directly on the page number (rather 
than the heading).

Changes and new features
For a comprehensive list of new features, please refer to New Features in DP, available 
in Digital Performer's Help menu.

Enhancements introduced in version 9.1.3

Version 9.1.3 provides improvements, optimizations, and refinements. Here are just a 
few highlights:

• Improved Hardware Insert plug-in latency detection. Added level meters and fixed a 
bug when pasting settings.
• Allow more than 32,000 MIDI tracks in a project.
• Improved support for Softube when tracks are reordered.
• Improved support for Melodyne.
• Improved latency compensation for VST2 plug-ins.
• Improved support for VEP and virtual instruments that have variable latency.
• Improved support for the RME Fireface driver.
• Fixed a bug where certain plugins (MX4, for example) would not get numbers 
appended to side-chain bus names.
• Fixed a bug where erasing a selection containing soundbites with fades would 
sometimes cause a click.
• Fixed a bug where editing the head of a soundbite with a fade on it’s tail would 
sometimes cause a click.
• Fixed an issue where chased MIDI events would not update faders and other graphical 
indicators.
• Fixed a bug where the main counter format was not being restored when opening a file 
in some cases.
• Fixed a bug where Wave files with time-stamps of > 0x7FFFFFFF would not spot 
correctly.
• Fixed an issue where pasting at an insertion point in a pop-edited soundbite would not 
place the data at the correct location.
• Fixed a bug where deleting chunks with the track selector showing could cause a 
crash.
• Fixed some popup menu behavior.



• Fixed a bug that could lead to a crash when edge-editing MIDI notes following the 
deletion of pitch bend data.
• Fixed an issue where using the scale tool on soundbite volume would not update 
playback such that the modification could be heard.
• Fixed a crash that could occur when closing various editor windows.
• Fixed an issue with recalling Mixing Board layouts.
• Improved mouse tracking when editing pitch bars.
• Fixed an issue where including Film Scoring Events in a movie bounce could cause 
frame rate irregularities.
• Fixed an issue with code signing the Windows installer.

Enhancements introduced in version 9.1.2

Version 9.1.2 provides many improvements, optimizations, and refinements. Here are 
just a few highlights:

• Fixed a bounce to disk crash caused by an issue involving non-active VST effects. 
• Fixed a problem where audio would sound choppy after inserting a post-fader effect.
• Fixed a crash that could occur if a clipping window was closed while one of its 
clippings was being auditioned. 
• Fixed a crash involving Melodyne. 
• Fixed an issue where project VIs would not work correctly when selected as MIDI 
metronome. 
• Optimized code that could impact opening projects with a large number of tracks. 
• Fixed an issue where the Ivory Synthogy would hesitate and glitch when beginning 
playback in pre-gen mode. 
• Fixed an issue where recording MIDI data into a track with sustain CC could clear the 
live state of the sustain pedal. 
• Fixed an issue where overdubbing notes in a MIDI track would halt sounding notes 
already on that track. 
• Fixed a case where track sysex data could cause a crash during playback. 

New features introduced in version 9.1

Version 9.1 introduces the following new features. For further information about these 
features, go to Digital Performer's Help menu > New Features in Digital Performer 9.

Reduced latency for audio I/O and VIs under OS X — Host buffer latency under 
CoreAudio has been cut in half. As an example, if you choose a buffer setting of 128 
samples, version 9.1 yields 256 samples of total host latency (one buffer on input and 
one on output), plus any hardware latency. This will improve audio I/O latency and 
virtual instrument performance.

Enhanced WASAPI driver performance under Windows — The latency of the 
WASAPI (Windows Audio) driver has been significantly reduced. This will improve audio 
I/O latency and virtual instrument performance. The CPU load of the sample rate 
conversion used in the Windows Audio driver has also been substantially reduced.



MAS engine optimization for small buffer settings — DP's MOTU Audio System 
(MAS) engine processing has been optimized to better support operation at smaller 
buffer sizes (for both Mac and Windows).

Next-gen Pre-gen™ engine — DP's Next-generation Pre-gen engine transparently 
pre-renders audio output from virtual instruments and plug-ins to dramatically reduce 
their CPU load. In version 9.1, this feature has been highly optimized for greatly 
enhanced CPU performance at small MAS buffer settings. The smaller your MAS buffer 
setting, the greater increase in efficiency you will notice relative to previous versions of 
DP. Running DP 9.1 with a small MAS buffer setting provides the best of both worlds: 
high rendering efficiency of existing tracks, while allow low latency play-through for 
recording new material.

DP seamlessly manages transitions between pre-generated audio and live audio as 
needed (such as when you record a virtual instrument live). In addition, virtual 
instruments are always available for preview activities, such as editing notes in the MIDI 
Graphic Editor or using a VI’s on-screen keyboard (previously they were only active 
when playback was underway). To fine-tune the responsiveness of plug-ins and virtual 
instruments, go to Setup menu > Configure Audio System > Configure Studio Settings 
and adjust the Prime Milliseconds setting.

MOTU has worked hard to ensure a high level of compatibility with third party virtual 
instruments and effects. There may be cases where pre-generation may not work as 
expected with a given 3rd-party plug-in. These cases should be reported to MOTU and 
the plug-in vendor so that compatibility can be fully established. In the meantime, you 
can run the plug-in or instrument in real time.

If you would like a plug-in or virtual instrument to run in real time only while its window is 
open (to improve level meter timing in the plug-in window for example), go to the mini-
menu and choose "Run Open Instances of This Plug-in in Real Time". Close the window 
to return to Pre-gen mode (or uncheck the menu item). This setting applies globally to 
all instances of that plug-in and is saved globally.

To force a virtual instrument track into real-time operation all the time (not just when its 
window is open), record-enable any MIDI track that targets the instrument. To force an 
audio track's effects into real time, the track can either be record-enabled or monitor-
enabled. Alternately, the effect can be placed on an aux track, either in a chunk or a v-
rack, with bussing used to access the effect. Aux track effects are always rendered in 
real-time.

Not all plug-ins can take advantage of pre-generation. For example, plug-ins that 
delegate their processing to hardware or other processes, such as UAD plug-ins or 
Vienna Ensemble Pro (VEP), can not run in pre-generation mode, and so will not benefit 
from its increased performance. In practice this is not much of a loss, since the 
processing work is already being offloaded from the real time signal path.



SMPTE-Z plug-in — The SMPTE-Z plug-in generates Longitudinal Time Code (LTC) 
while locked to DP’s timeline or while running independently in Freewheel mode. The 
Stillframe option causes time code to continue to be generated even when DP’s 
transport is stopped (parked on one frame). Time code can be routed anywhere via the 
audio track’s output assignment, allowing for accurate time code sync in a wide variety 
of situations.

Hardware Insert plug-in — The Hardware Insert plug-in functions just like other DP 
effects plug-ins, but loops the channel’s audio signal to a piece of outboard hardware for 
external processing by the hardware. It can be instantiated in line with other software 
plug-ins and even saved as part of an effect chain clipping. The plug-in includes a 
button that pings the external hardware, measures the resulting latency and 
automatically compensates for it. The hardware insert plug-in allows you to easily 
incorporate outboard gear into your DP effects chains. 

In addition to the new features outlined above, version 9.1 also introduces the following 
enhancements:

• Track level meters now display the track's level post-fader and pre-pan. 
• Fixed a problem where plugging or unplugging headphones while using built-in audio 
could cause MAS to stop and report a hardware change.
• Fixed a latency compensation bug with side-chain outputs of VIs running in pre-gen 
mode. 
• Fixed a bug with latency compensation, where using voice tracks as a "recordable aux 
track" would not correctly align the source material. 
• Fixed assigning midi inputs in the Track Assignments dialog. 
• Reduced wait-time when switching between chunks with a high track count. 
• Fixed a crash when reducing the number of sends. 
• Fixed backing window to match effect window when resized. 
• Allow maximum value in automation lane to be selected. 
• Fixed an issue where a track might not immediately appear when moved from a closed 
folder to an open one. 
• Simplified the studio setup dialog. 
• Fixed a bug where VST or AU wrappers would crash if validation was performed after 
MAS had been turned off and back on again. 
• Fixed an error message that would be displayed when hitting delete in the waveform 
editor. 
• Fixed a problem where some VSTs would seem to hang during validation. 
• Fixed saving as AudioDesk files from DP. 
• Fixed DP 9.x file IO compatibility with DP 8. 
• Fixed crash when duplicating label in a Console. 
• Fixed a crash when double-clicking the MIDI learn button. 
• Fixed a bug where removing a mono-to-stereo effect could leave the track playing only 
to the left channel.
• Fixed a crash that could occur when switching chunks from the SE mini-menu. 
• Fixed an error that would be displayed when opening a project containing a movie with 
no audio track. 



• Fixed an issue where cut copy paste wasn't working in OS modal dialogs like the Save 
As window. 
• Fixed a print bug where the Page Setup scale factor wasn't working as expected.
• Updated the English and Japanese PDF manuals (in the Help menu).
• Fixed issues with Avid Artist Mix / EuCon surfaces where track names might not show 
up or the control surface might disconnect in sequences with lots of tracks.
• Fixed issues with track layouts not properly duplicating with sequences.
• Fixed an issue where hitting TAB triggered the search filter whether or not the Track 
Selector was open.

New features introduced in version 9.0.2

Version 9.0.2 introduces the following new features:

Support for 3rd-party video hardware — On OS X 10.7 or later, you can now use 
devices from Blackmagic Design and AJA Video Systems to stream video output from 
Digital Performer. Choose the device in the same fashion as described for MOTU video 
hardware in the DP User Guide. This feature is Mac-only.

Support for Softube's Console 1 — Softube's Console 1 is an integrated hardware/
software mixing solution that brings the feel of a real console to Digital Performer. 
Console 1 includes SSL SL 4000 E, a modeled analog console channel plug-in with 4-
band EQ, compression, emulated analog console saturation, and a unique Dynamic 
Shaper. For more information, see http://www.softube.com/console1.php.

More vertical zooming in the Tracks Overview — Version 9.0.2 adds more vertical 
zoom steps to the Tracks Overview so that tracks can be even taller.

View menu — The new View menu consolidates many features in Digital Performer 
related to managing view-related commands and preferences. The "View Filter" 
command has been moved to the View menu and renamed "Filters". A large number of 
commands for manipulating the visibility of tracks in windows have been added, and 
they are also available in the standalone Track Selector's mini- menu.

Track selector enhancements — The Tracks Overview can now display the Track 
Selector like other windows. The Track Selector can be popped out of the Consolidated 
Window as a stand-alone, global window that affects all windows. The Tracks Selector 
list now indicates which tracks are currently record-enabled (bold) and disabled (italic), 
at a glance. New commands in the new View menu allow you to take a snapshot of 
which tracks are currently visible in the Track Selector and save the snapshot as a track 
layout. Saved track layouts appear in the View menu and Commands window list, 
where they can be assigned hot keys for instant recall. Track layouts are bound to their 
sequence chunk and saved with the project.

Select All — The Select All command now only applies to the tracks visible (including 
closed folders) in a given window rather than all tracks in the sequence.



Muting selected audio — Using the Mute Selection command to mute or unmute a 
time range selection now scissors audio at the end points of the selection, e.g. you can 
select a subregion of a soundbite and toggle mute to mute just the selected area.

Display preference for grid lines — There is a new display preference for showing 
and hiding grid lines, instead of their visibility being bound to snapping being enabled or 
disabled. This defaults to being turned on. If you prefer to only see the edit grid while 
snapping, uncheck View > Grid > Edit Lines and make sure Edit Lines While Snapping 
is enabled.

Countoff while slaved to external sync — DP's Countoff feature now works while DP 
is slaved to external sync and AutoRecord is enabled. The click counts off to DP's 
punch-in time.

Send knobs readouts — Added readouts for send knobs on mouse-over that you can 
optionally type into. Option-clicking will immediately start editing the readout.

New commands — New commands have been added for changing which track or 
chunk is showing in the focused editor and duplicating takes on two or more selected 
tracks.

Enhancements introduced in version 9.0.2

Version 9.0.2 provides many improvements, optimizations, and refinements. Here are 
just a few highlights:

• [Mac] Fixed a crash with the Welcome window triggered by certain third-party plug-ins.
• [Mac] Fixed the Spotlight help menu in Japanese.
• Fixed a crash importing groups of sound files with mismatched sample rates.
• Fixed an issue where dragging a patch change to a clipping from the ME would hang.
• Fixed a crash when instantiating a surround panner via the right-click context menu.
• Fixed an issue where the last tempo event in the conductor track overview in the 
Tracks Overview might not appear graphically.
• Fixed a crash merging a pop-edited soundbite.
• Record next/previous track commands now follow the track order based on what's 
visible in the Tracks Overview.
• The Show/Hide Track Selector command now works in the Tracks Overview.
• Fixed a crash deleting a console item.
• Fixed the scroll bar in the Sequence Editor's track selector.
• Fixed a crash with surround send panners when switching the send destination.
• Kontakt 5.5.1 VST no longer fails examination.
• Fixed an issue where very large timestamps might not export correctly in WAVE files.
• Improved performance of the Movie window.
• Improved graphical performance when recording lots of audio.
• Added an embedded Track Selector to the Tracks Overview.
• Fixed deleting effects from custom categories.
• Fixed zooming in the conductor track ruler in the Sequence Editor.



• Fixed mute tool undo.
• Fixed an issue where certain clicks might not play back at sample rates other than 
44.1kHz.
• Fixed issues resizing effect windows.
• [Win] Fixed Japanese localization in the L.A.M.E export plugin.
• [Mac] Use the proper system font for menus on 10.10+.
• Floating windows except toolbars no longer hide when switching to another 
application.
• Enabled "Edge Edit Copy" by default.
• Newly created soundbites will be labeled as "bite#.4" instead of "bite.4" to remove 
ambiguity so that bites intentionally ending with numbers (e.g., time code) don't get 
treated as bite numbers.
• Improved project sizes and load and save times in large templates with lots of tracks.
• [Win] Fixed the Welcome Window on Windows 10.
• Fixed a graphical issue where plug-in UIs or consolidated window cells might not be 
placed correctly after dragging the containing window.
• Fixed a crash when restoring a window set with the QuickScribe window.
• Fixed an issue dragging multiple items to a category in the effect chooser.
• Fixed a crash when copying a console item.
• Fixed a crash when attaching to a Mixing Board item while in MIDI Learn mode.
• Fixed a crash when undoing during analysis.
• [Win] Fixed an issue where MP3 exports wouldn't have the .mp3 extension.
• Fixed an issue where opening an empty plug-in window with Shift-F wouldn't float 
according to the preference.
• [Win] Fixed international keyboard support for certain characters, such as '<' and '>' on 
Italian keyboard layouts or chords involving the Alt Gr key.
• Fixed an issue where tap tempo didn't work reliably when tapping faster than the 
current tempo.
• Fixed an issue where nudging by milliseconds the same amount in either direction 
might be off by a few samples from the initial position.
• Fixed an issue where imported movie audio didn't have the correct timestamp.
• Fixed the pitch bypass button.
• Improved performance of commands encompassing lots of tracks.
• Fix occasional crashes caused by unloading plug-ins dynamic libraries when shutting 
down MAS.
• Fixed a crash when inserting a CC into the MIDI Editor.
• Fixed a bug where rectified waveforms weren't drawing correctly.
• Improved display of muted soundbites and MIDI notes.
• Added the Waveform Editor to the Open In editors in contextual menus where 
appropriate.
• Changed the default selection color to the theme selection color instead of the system 
selection color.
• Fixed an issue where the Erase command might not correctly be bound to the Delete 
key.
• Made the insertion point more visible in dark themes.
• Fixed a bug where VSTs or Carbon-based AUs weren't displayed properly when 
running in 32-bit.



• Fixed crashes hiding and showing lanes.
• Improved the performance of undos involving large numbers of tracks.
• [Win] Fixed pencilling CCs in the SE.
• [Win] Fixed a hang when resizing the movie track in the SE.
• Improved performance of the EuCon control surface driver with large numbers of 
tracks.

Enhancements introduced in version 9.0.1

Version 9.0.1 provides many improvements, optimizations, and refinements. Here are 
just a few highlights:

• Fixed a crash inserting continuous data in the Sequence Editor.
• Fixed selection in lanes in the Sequence Editor.
• [Mac] Fix drawing issues where plug-ins might appear behind the Consolidated 
Window cells.
• Allow MIDI Learn to target mixing board controls.
• Fixed an issue where the inserted pencil type might not match the menu in the MIDI 
Editor.
• Improved performance when opening the Sequence Editor.
• Fixed an issue where MIDI output menus would be disabled after using Track 
Assignments.
• Fixed saving of VST presets.
• Fixed a bug with patch changes in MX4.
• Fixed a graphical issue where undoing or redoing a comp take segment would not re-
display at first.
• Fixed an issue where only the first Device Group was assignable.
• Fixed a crash in the Drum Editor.
• Fixed the Change Velocity window in the Nine theme.
• Fixed an issue where Aux tracks could be set to Note or Pitch edit layers erroneously.
• Fixed an issue where plug-in tails might get clipped when bouncing with iZotope 
Ozone, UVI Relayer and others.
• Fixed an issue where iZotope Ozone 6 will appear bypassed when not playing back. 
• [Mac] Allow MMC via the IAC bus.
• Fixed an issue where the mixing board might be out of sync with its Track Selector.
• Fixed a crash when toggling the movie floats on top preference.
• Draw the sound bite's selection highlight in the Sequence Editor under the waveform.
• Fixed a crash with Snip in the Waveform Editor.
• Changed "Fix partial measures" back to on by default.
• When opening a document with partial measures and the preference on, we now ask 
the user whether to correct the partial measures or leave them as is.
• Fixed Paste Repeat.
• [Win] Fix an issue inputting international text involving the Alt Gr key (e.g. @ in 
German).
• Show Marker grid lines in the Tracks Overview like other editors.
• Fixed an issue with disconnected controls in the Mixing Board and Channel Strip.
• Increased the idle rate of VSTs, which should improve the redraw speed of plug-ins 



that depend on it such as Serum.
• Fix an occasional crash in the VST version of BFD3.
• Fixed a Mixing Board crash when selecting multiple V-Rack tracks in the Track 
Selector.
• Fixed an issue where simply clicking items in lists such as the Tracks Overview might 
move the row.
• [Mac] Fixed graphical issues printing parts in QuickScribe.
• Fixed an issue where the search field wouldn't appear in the undocked Markers 
window.
• Restored the Console item context menu.
• Fix crashes in QuickScribe in some documents with lyrics.
• Updated the Japanese documentation, including the User Guide.
• [Win] Fixed right-clicking in MAS plug-ins.
• Fix an issue when trying to MIDI learn the mute or solo buttons in the Mixing Board.
• Fixed scrolling in text boxes in the Track Inspector and Lyrics windows.
• Fixed an issue where the Movie window might not float properly when undocked from 
the Consolidated Window, despite the user's preference.
• More performance improvements for the Sequence Editor with lots of tracks.
• Updated to the EuCon 3 SDK.
• Fixed improper button labels in the offline activation window.
• Fixed a bug where freezing a track wouldn't properly update the sends on the frozen 
track.
• Widened the plug-in name column in the Effect Chooser.
• [Mac] Correctly install the DP9 document icons.
• Make the Tracks Overview divider the same width as the Consolidated Window 
dividers.
• Fixed an issue where not all VST instruments were properly loaded as instruments.
• Fixed zooming across lanes.
• Fixed some commands that toggle windows open and closed, e.g. the Track Selector 
command.
• Added scrolling to change values in MX4.
• Fixed scrolling in the Project Notes window.
• [Mac] Fixed an issue moving the movie window between a Retina and non-Retina 
display.
• Fix highlighting of piano roll ruler in Pitch lanes in the Sequence Editor.
• Tweaked contrast and colors in Nine.
• Fixed the button artwork in Savannah and Alloy.
• Disable the buffer size menu during playback.
• Added the Japanese plug-in guide.
• MX4 Japanese localization.

Attention Mac BPM, Ethno, and Electric Keys owners

If you use BPM, Ethno, and/or Electric Keys with Digital Performer on the Mac, and you 
wish to run DP9 in 64-bit mode, use the AU or VST versions of these instrument plug-
ins (as there is no 64-bit MAS version). If you plan to transfer DP9 projects between a 
Mac and PC, use the VST version, which will allow the plug-in settings to transfer back 



and forth seamlessly. When migrating projects created in earlier versions of DP to 
Version 9, you can transfer settings from the old MAS version to the new AU (or VST) 
version of the instrument as follows:

1. Open the project in the older version of DP.
2. Save the instrument plug-in settings from within the plug-in (as a BPM Performance, 
an Ethno Multi, or an Electric Keys Combi).
3. Open the project in DP9.
4. Load the settings (performance, multi or combi) into the AU version of BPM, Ethno or 
Electric Keys.

Note: MachFive 3 settings will successfully transfer from old DP projects into DP9, so 
you don't need to do this procedure for MachFive 3.

*****

We hope you enjoy using Digital Performer 9. We welcome your comments and 
suggestions.

Sincerely, 

The Digital Performer Development Team
www.motu.com/techsupport
www.motu.com/suggestions
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